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GUIA DE USO DEL SOFTWARE ETABS V9.7.4 

 

1. INTRODUCCION 

Esta guía pretende aclarar algunos conceptos sobre el uso del programa ETABS, en su versión 

9.7.4 para la realización de un análisis modal espectral de un edificio simple. No es el alcance de 

la misma el explicar los conceptos referidos a un análisis de cargas, método estático, aspectos 

reglamentarios como la verificación de la regularidad estructural, análisis modal, espectros ni 

análisis modal espectral. Tampoco se ahondará en el comportamiento de los distintos elementos 

estructurales (frames, shells, membranes, etc) ni se pretende utilizar todas las características del 

programa. Nos limitaremos a crear un modelo simple para entender el uso del programa y queda 

al alumno la tarea de investigar a fondo el mismo. 

 

2. USO DEL SOFTWARE 

2.1 Creación de la geometría. 

El primer paso para comenzar es la definición de la geometría de la estructura. Para esto debeos 

tener definida la estructura (predimensionada). 

Al inicial el programa vemos la pantalla de inicio y luego una ventana negra. Lo primero que 

debemos hacer es setear las unidades de trabajo en el menú desplegable que se encuentra en la 

parte inferior derecha de la pantalla. En este caso elegiremos  kN,m. 

 

Luego en el menú, elegimos “File->New Model”. Se desplegará una pantalla y elegimos 

“default.edb” para comenzar de cero.  

 

*NOTA: esta demás aclarar que se debe ir guardando el modelo cada cierto tiempo para evitar 

perder información si ocurre un error. 



*NOTA: el procedimiento explicado en esta guía no es el único para generar un modelo de 

análisis y puede variar además, dependiendo de la versión del programa utilizado. 

 

 

Se abrirá la pantalla donde habrá que definir las grillas en X e Y y los niveles de los pisos. Se 

puede elegir una grilla uniforme colocando la cantidad de líneas en X e Y y la separación entre 

ellas y el número de pisos con la altura del primero de ellos y del piso típico.  Sin embargo, si el 

edificio no tiene las grillas equidistantes y los pisos de igual altura, es elegir “Custom grid 

spacing” y “Custom story data” para ingresar ya sea la separación de grillas o las progresivas y 

las alturas de cada nivel.   

 

2.2 Definición de materiales, secciones y elementos. 

Con las grillas ya definidas, se procede a definir los materiales y secciones a utilizar. 

 

Para ello entramos al menú “Define->Material Properties” .Se abrirá una ventana donde 

elegimos “ Add new material”. Acá definimos nuestro material a utilizar. Pulsamos  “OK” al 

finalizar y “OK” si no vamos a crear más materiales. 

 

En este paso, es conveniente colocar que la masa del material es “0.00” para que al momento de 

que el programa convierta los pesos en masas y se la sume a las masas existentes no se dupliquen. 



*Nota: En versiones más nuevas no se puede elegir individualmente masa y peso ya que están 

relacionadas por “g”. En este caso veremos de modificar el multiplicador cuando se defina la 

sección. 

 

Posteriormente, en el menú hacemos click en “Define->Frame Sections” para definir las 

secciones de los elementos de barra (vigas, columnas, tabiques) a utilizar. 

 

*Nota: Los tabiques en general se modelan mediante placas (Shell), sin embargo se pretende 

realizar un modelo simple y esto escapa al alcance de esta guía. 

 

Se abrirá una ventana donde elegiremos “Add I/Wide flange” y en el menú desplegable elegimos 

“Add Rectangular” 

 

Pasamos a definir el ancho (width) y altura (Depth) de nuestras secciones, junto con el material y 

el nombre. 

 

*Nota: las secciones en ETABS tienen dos ejes locales, eje 2 y eje 3. Siempre el eje 3 es 

perpendicular a la altura de la sección y en general, al orientar la sección en el espacio, queda 

paralelo al eje Y global de la estructura. Si esto ocurre, por ejemplo en una columna y queda la 

sección mal orientada, se puede o bien girar la sección (Assign->frame/Line->Local axes y 

colocar 90°) o definir la sección con un width>depth. 

 

Al definir la sección, hay que hacer click en “Set Modifiers” para ingresar los valores de 

degradación de rigidez de la misma dados por el reglamento. (Ver INPRES CIRSOC 103-parte II 

para degradación de vigas, columnas y tabiques.). Consideremos que se va a modificar la inercia 

de las vigas por 0.35 para hacerlas efectivas y 0.7 en columnas y tabiques. 



 

En este caso se modifica la inercia de flexión. Como el eje 3 es horizontal y la flexión se da 

alrededor de este eje, el valor de modificación se coloca para el J33 (Moment of inertia about 3 

axis). En este caso también se colocó un modificador de masa =0 a la sección. Si ya se colocó el 

material con masa =0 no haría falta, pero si no se pudo hacer (como en versiones más modernas), 

se modifica en este paso. 

 

Para las columnas, la modificación se debe colocar tanto en el momento de inercia respecto a 3 

como el respecto a 2. 

 

Para modelar las losas haremos una pequeña salvedad. Si bien las losas son elementos de placa 

con flexión fuera del plano y se podrían usar elementos tipo “shell” o “plate”, estos elementos no 

transmiten bien las cargas a las vigas. Debido a esto vamos a modelar las losas con elementos tipo 

“membrane” cuyo comportamiento es membranal (esfuerzos contenidos en el plano del 

elemento). Sin embargo, esta modelación permite transferir cargas a las vigas de forma correcta. 

 

Para ello ingresamos al menú “Define-> Wall/Slab/Deck sections” y  en la pantalla que aparece 

elegimos “Add new slab” 



              

Le damos espesor a “membrane” y “bending” y elegimos type “membrane”. 

Terminado de definir todas las secciones a utilizar se procede a dibujar la estructura. Para esto 

ponemos una vista del modelo que nos sea cómoda (por ejemplo en planta, o en vista de un plano 

específico) mediante los iconos 3d-plan-elev.  Mediante estos iconos podemos elegir la vista por 

ejemplo de la planta 2 o la línea estructural 3 o la B, etc. 

 

Procedemos a dibujar las vigas y columnas. Por ejemplo, para dibujar vigas en planta o 3D o en 

vista o columnas en vista o 3D, elegimos “Draw->Draw line objets->Draw Lines (plan, elev, 

3D)” o su icono correspondiente. 

 

Al clickear sobre esta opcion se desplega un menu pequeño donde se debe elegir que sección se 

va a dibujar. 

 



Hecho esto, procedemos a  indicar el nudo inicial y final de la grilla en donde ira el elemento 

haciendo click en cada punto. 

 

Para dibujar las losas elegimos “Draw->Draw Area Objetcs->Draw rectangular área” del menú 

o el ícono correspondiente. 

 

Como opción, se puede dibujar un piso completo y luego seleccionar todo con el mouse y en el 

menú “edit->replicate” se puede elegir copiar la estructura en los pisos restantes.  

 

Habiendo completado el modelo procedemos a colocar los vínculos. Por defecto, ETABS coloca 

vínculos simples en cada columna en la base, pero a los efectos de esta modelación vamos a 

cambiarlos por empotramientos.  Para esto elegimos como vista “plan”, hacemos click en 

“BASE” y tendremos una vista de los apoyos. Seleccionamos todos con el mouse y elegimos 

“Assign->Joint/point->Restraints (supports)”, o su icono correspondiente y restringimos los 

6gdl para los nodos y aceptamos. 

 

Dado que las losas son rígidas en su plano constituyen un diafragma rígido. Para asignar este 

“constraint” al modelo primero definimos los diafragmas. Para eso vamos a “Define-

>Diaphragms” y en la ventana que se abre elegimos “add new diaphragm” y le damos un nombre 

y seleccionamos “rigid”. Hay que definir tantos diafragmas distintos como niveles tenga el 

edificio. 

 

Luego, elegimos como vista “plan” y “story1,  seleccionamos todos los nudos y elegimos 

“Assign->joint/point->Diaphragm” o “Assign->Shell/área->Diaphragms”, esta última opción 

es mejor ya que se adapta al automesh del programa. Clickeamos en el nombre del diafragma y 

“OK”. Hacemos esto para cada piso del edificio.  



*Nota:  Cada nivel debe tener un diafragma independiente y no puede compartir nodos con los 

diafragmas de otros niveles. 

 

Si elegimos el icono de “Set Building view Options” y clickeamos en “objetct fill” y “diaphragm 

extent” veremos algo asi 

 

Donde las líneas confluyen a un punto con el nombre del diafragma asignado. 

En este punto si se ejecuta el programa debería correr sin problemas y mostrar la deformada por 

peso propio al terminar. 

 

2.3 Asignación de masas y cargas. 

Luego de tener la geometría completa comenzamos a asignar las cargas al modelo.   Como se ha 

definido un material con peso propio y los elementos tienen una sección y una longitud, el peso 

propio de la estructura es calculado automáticamente por el programa.  Lo que resta asignar es la 

carga adicional al peso propio, en este caso la “obra muerta o sobreimpuesta” (OM), que 

corresponde a pisos, contrapisos, cielorrasos, aislaciones, etc., la “tabiquería”, que contempla 

incidencia de las divisiones livianas dentro del edificio y la “carga viva o de uso” (LIVE), que 

depende del destino de la construcción. 

Tanto la “obra muerta” y la “tabiquería” son cargas tipo “D” al igual que el peso propio, y la carga 

viga es tipo “L”. 

 

Para esto, lo primero que hay que hacer es definir los tipos de carga. Esto se hace en “Define-

>Static Load Cases”.  En la ventana que se abre aparece por defecto la carga DEAD con 

multiplicador de peso propio igual 1.0 y la carga LIVE con multiplicador de carga igual 0.0 



 

Agregamos las cargas OM, Tabiquería, como cargas “DEAD” y multiplicador de peso propio 

igual a 0.0 ya que no modifican ni tienen en cuenta el peso de los elementos y las cargas FX1, 

FX2, FY1, FY2 del tipo “QUAKE” y “user loads”, las que nos servirán para comprobar la 

regularidad estructural en planta. 

 

Posteriormente pasamos a agregar las cargas correspondientes. En este paso ya se debe contar con 

un análisis de carga para evaluar OM, Tabiquería y Live.  Para el ejemplo consideraremos 

OM= 1.5 kN/m2,   Tabiquería= 1.0 kN/m2 y LIVE=2kN/m2.  Estos valores deben ser calculados 

para cada caso particular. 

 

Luego, colocamos el modelo en la vista que más nos convenga, seleccionamos las losas y 

elegimos “Assign->Shell/Area Loads->Uniform” y  colocamos el valor de carga, la dirección y 

el tipo. 

 

Al finalizar, en el menú “Define->mass source”, definimos la combinación de cargas para 

calcular las masas reactivas. 



 

Elegimos que la masa sea considerada de la propia, la especificada y las cargas, así el programa 

transforma las cargas D y L en masas, al igual que el peso propio.  En este caso se utilizó como 

combinación D+0.25L. 

 

2.4 Ejecución del programa 

Luego en “Analyze->set Analysis options” elegimos “full 3D” y “Dynamic analysis” y dentro de 

esta opción colocamos el número de modos a calcular, que en este caso serían 3 por cada nivel. 

 

Terminado este paso, si corremos el modelo se habrá realizado el análisis modal completo. 

El paso siguiente es colocar las cargas estáticas para realizar la comprobación de regularidad 

estructural en planta. 

 

Para esto, debemos calcular un peine de fuerzas acorde a la distribución de masas, con lo cual se 

puede en principio generar una combinación de cargas D+025L y que el programa evalúe las 

cargas por piso, o bien transformar las masas por pisos a cargas o bien realizar el cálculo a mano. 

 

Para generar una combinación de cargas vamos a “Define->Load Combinations” y  ahí elegimos 

“Add new combo”, le damos un nombre, elegimos como type “ADD” para que sume los efectos 

y colocamos los multiplicadores para cada carga. 



 

Luego de correr el programa, en “Display->show tables” elegimos las siguientes opciones 

 

En “Select load cases” apretamos “clear all” y en “Select Cases /Combos” seleccionamos 

solamente D025L. 

Veremos estas salidas. 

 



Acá vemos las masas por pisos, las cuales podemos transformar en pesos.  

Cabe aclarar que en esta misma pantalla se pueden visualizar las coordenadas del centro de rigidez 

XCR e YCR, las que se encuentran a continuación de XCM e YCM que corresponden al centro 

de masas. 

 

Acá vemos la carga axial por piso en cabeza y pie de cada nivel, por lo tanto, con unas pocas 

cuentas podremos saber el peso de losa y vigas por un lado y de columnas y tabiques por otro y 

así calcular el peso por nivel. 

 

Calculado el peine de fuerzas, ingresamos a “Define->Static Load Cases” otra vez y colocamos 

las cargas en los estados de fuerzas laterales. 

 

Click en “modify lateral load” 



 

Definimos el peine de fuerzas aplicado en el Centro de masas con excentricidad 0.05L 

Los demás estados son similares considerando que las excentricidades son 0.05L y -0.05L en cada 

caso. 

 

Ahora se analiza la estructura de nueva y basta con elegir ver la deformada para el estado 

correspondiente y extraer los desplazamientos de los extremos de cada nivel para cada estado de 

carga.  Por ejemplo para FX1 

 

Y clickeando con el botón derecho en un punto del modelo obtenemos 



 

 

*NOTA: Algunos ítems y métodos para ver gráficamente los desplazamientos pueden variar de 

una versión a otra del programa. 

 

Finalmente, debemos cargar el espectro de diseño para realizar el análisis modal espectral. 

Lo primero que hacemos es definir el espectro, esto se realiza en “Define->Response Spectrum 

Functions”. Dentro de la pantalla que se abre elegimos “spectrum from file” y cargamos un 

archivo de texto donde tengamos los valores del espectro de diseño en formato Periodo-

Aceleración. 

 

Ahora definimos los casos espectrales, para esto ingresamos a “Define->Response Spectrum 

Cases”. Click en “Add New Spectrum” 

 



        

Le damos un nombre al caso (serán dos casos, uno para dirección X y otro para dirección Y) y 

definimos el tipo de combinación (SRSS) y cuál es la función del espectro que previamente 

definimos y el factor de escala. Dado que el espectro esta en %g, el factor de escala es 

gr/R.  Sin embargo en este ejemplo consideraremos g=9.81, r=1.0 y R=1.0 (Vale decir que se 

debe utilizar el valor de R que corresponde a cada dirección de análisis. 

 

*NOTA: Según el reglamento INPRES CIRSOC 103 parte I, el valor mínimo de R=1.5 para 

respuesta elástica. En este caso se elige el valor R=1.0 solo a los fines de mostrar cómo se cargan 

los datos. 

 

Finalizado esto, ya se puede correr el modelo y realizar el análisis modal espectral. 

 

2.5 Visualización de resultados. 

Para ver los resultados se puede elegir del menú el mostrar solicitaciones para los estados de carga 

incluyendo los espectrales o ver resultados en tablas. En esta caso, lo fundamental se encuentra 

haciendo click en lo siguiente. 

 



 

Además, en “File->Print Tables->Summary Report” existe información adicional para los 

resultados. 

 

 

 

 

 

 

 

 

 

 

 

 

 


